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Types of charts in excel

And the last two plots also have variations, which are with Markers. Going back to our plane spotting, we want to know when we are most likely to spot aircraft flying overhead. Once you've created your chart, try going one step further by highlighting the minimum and maximum values to make them stand out. Value data is distributed evenly along
the vertical axis. We want to break up the marks into groups of ten (for example, 50 to 60, 60 to 70, and so on), and see how many students landed in each group. For example, the table below contains a student’s scores secured in two tests. Here's what we end up with. The graph visually helps compare the student’s performance in the two tests
subject-wise, making the analysis more straightforward. You want to adjust the independent axis scales of a scatter chart to reveal more information about data that includes pairs or grouped sets of values. It then combines the x- and y-values and shows them as data points in intermittent intervals. The plot shows the categories on the Y-axis or the
vertical axis and the values along the X-axis or the horizontal axis. By showing the sum of the plotted values, an area chart also shows the relationship of parts to a whole. 3-D Clustered Column. It's easy to see which day had the most activity. Step 1: Click on any cell in the source table and follow the path Insert - Column or Bar Chart — 2-D
Clustered Column chart. You want to make that axis a logarithmic scale. We can use the Histogram chart to determine the students’ age groups. Or, even better, you can combine your charts with drop-down lists to make them dynamic. And here is how to use the inbuilt chart. Excel VBA - All in One Courses Bundle (35+ Hours of Video Tutorials) If
you want to learn Excel and VBA professionally, then Excel VBA All in One Courses Bundle (35+ hours) is the perfect solution. Once you have created your chart, you can double-click any of its elements to open the Format Pane on the right, where you can personalize the axis options, chart colors, data labels, and all other parts of your chart. Here are
the top ten types of charts in Excel we can use in our daily tasks. Here is how to use a Pie chart to display the above data graphically. Step 4: Double-click the chart title element in the chart area to update it and obtain the below chart. Step 3: Click the ‘+’ icon (Chart Elements) and check the Data Labels box. A Bar Chart has the following sub-types —
Clustered Bar Stacked Bar 100% Stacked Bar 3-D Clustered Bar 3-D Stacked Bar 3-D 100% Stacked Bar Area Chart Area Charts can be used to plot the change over time and draw attention to the total value across a trend. In the table below, we counted the number of each type of aircraft that flew overhead. Example The below table shows the
scores secured in science subjects by five students. The available Area charts in Excel are 2-D and 3-D Area, Stacked, and 100% Stacked Area charts. XY scatter charts are a great way to see if there is a correlation between two data sets. And then, click the ‘+’ icon again to close the feature. Description Bar charts in Excel help perform comparisons
between categories specified in the source data. Excel offers the following major chart types — Column Chart Line Chart Pie Chart Doughnut Chart Bar Chart Area Chart XY (Scatter) Chart Bubble Chart Stock Chart Surface Chart Radar Chart Combo Chart Each of these chart types have sub-types. You can see which day had the most activity over the
three weeks, and each day is divided into three one-week periods, with colors representing each week. And the plot will be in the form of color-coded columns, indicating the positive and negative values. And Excel offers 2-D and 3-D Clustered, Stacked, 100% Stacked, and 3-D Column charts. Radar charts visualize comparisons of various
characteristics. Arrange the data in columns or rows on the worksheet. As in a topographic map, colors and patterns indicate areas that are in the same range of values. And it is an ideal graph to analyze the given data when there is more than one data series. Step 4: Repeat steps 3 and 4 explained in the Column Chart section to update the chart and
axes titles and achieve the below Line chart. 3-D 100% Stacked Column. The group widths (also known as bins) were not automatically set to ten. The line chart in the screenshot below enables you to quickly see that Man Utd are scoring more goals each season, Arsenal are scoring fewer goals as time goes on, and Chelsea are staying about the same,
except for a dip in season 4. And all the sectors put together forms a pie, with the whole pie denoting the sum of all data points. So, for example, (60, 70] means that the score of 60 is not included in that column, but the score of 70 is. The above Stock chart shows the daily high, low, and average temperatures as a High-Low-Close plot. And follow
steps 2 to 4, explained in the Column Chart section, to update the chart and axes titles in the above chart. And the steps are as follows: Step 1: Select the cell range A2:D7 and click Insert — Line or Area Chart — 2-D Line chart. Column Chart Column charts are the best way to show simple data comparisons. It also tells us to not be too hopeful on
Tuesdays and Wednesdays. 3-D Column. Here is how to display the above data graphically using a Column chart for visual comparison. The plot shows the category data uniformly distributed along the X-axis and the numeric data spread evenly on the Y-axis, with each data series represented as a line. Example The following table contains the ages of
ten students. It is similar to the Line graph, except the Area chart shows the region between the trend line and the X-axis in color. And update the chart and axes titles using steps 2 to 4, explained in the Column Chart section. Description Scatter charts in Excel help in displaying and comparing scientific and statistical data. Values for horizontal axis
are not evenly spaced. A Scatter chart has the following sub-types — Scatter Scatter with Smooth Lines and Markers Scatter with Smooth Lines Scatter with Straight Lines and Markers Scatter with Straight Lines Bubble Chart A Bubble chart is like a Scatter chart with an additional third column to specify the size of the bubbles it shows to represent
the data points in the data series. The plot will be inaccurate if we click only a cell in the table and select the Line chart. And ensure the source data contains less than seven categories for best results. Example The table below shows a firm’s monthly revenue fluctuations, with the revenues in January and June being the initial and final figures.
Therefore, they are ideal for showing trends in data at equal intervals, such as months, quarters or years. Also, when you use an area chart with various data sets, the comparisons between these variables are even easier to see than in a line chart. Consider using a Scatter chart when — You want to change the scale of the horizontal axis. Step 1:
Select the cell range A2:D7 and navigate the path Insert — Stock chart. And each column represents the score secured in the corresponding subject in each test. However, we must ensure that the source data is in the correct order to achieve the correct plot. Example The below table contains the quarterly sales figures of a firm for 2022. You can also
change the chart type later. Next, move the Monthly Savings in $ series one step down using the same method. A Stock chart has the following sub-types — High-Low-Close Open-High-Low-Close Volume-High-Low-Close Volume-Open-High-Low-Close Surface Chart A Surface chart is useful when you want to find the optimum combinations between
two sets of data. Another way to assess correlations between two variables is through a combo chart. Also, we can change the number of bins to show the source data using the Format Axis settings for the X-axis based on the extent of our analysis. And the charts make it easier to interpret the relationship between them. The above plot will be more
meaningful if the monthly income bar comes first, followed by the monthly savings and expenses bars. Furthermore, there are two types of Histogram Excel charts, Histogram and Pareto. The plot shows the categories on the X-axis or the horizontal axis and the values along the Y-axis or the vertical axis. The above Column plot depicts the monthly
sales figures of the firm in 2021 and 2022 in the blue and orange columns, respectively. The Waterfall chart can help us view such revenue variations graphically. Step 2: Click the chart area to enable the Chart Elements options. To create a Stock chart, arrange the data in columns or rows in a specific order on the worksheet. You can still use a
column chart if you have multiple related data series. This bar chart shows the day of the week on the y-axis, and the number of planes on the x-axis. The 3D surface chart tells us that Saturdays are the best days, particularly early in the month. The above Waterfall chart shows the initial and final total revenues in grey. And the small horizontal line on
each vertical line denotes the average temperature on the specific date. Stacked Column. It's clear to see in our combo chart that the higher the temperature, the lower the rainfall. Excel offers Scatter, Scatter with Smooth Lines, and Straight Lines charts. Description The Stock charts in Excel visually depict fluctuations in entities, such as stock
prices and annual temperatures. When we plot the income data for three weeks, the area chart gives us a couple of things to note. And then click the ‘+’ icon again to close the feature. We can see straightaway that teams who score more goals (y-axis) tend to concede fewer (x-axis), and vice versa. To create a Bar Chart, arrange the data in columns or
rows on the Worksheet. Notice how quickly you can see that just over a quarter of the planes were Hawk T2s. And the Blue and Orange columns indicate the increase and decrease in the monthly revenues. And it makes it easier to review the firm’s sales performance from January to June in the two specified years. In this example, we have 20
students and their exam marks. To change how each data set is visualized, select your chart, click "Chart Design," and then click "Change Chart Type." You can then change the settings in the dialog box that opens. Bar charts work exactly the same way as column charts, but the series names are on the y-axis, with the values along the x-axis. Line
charts can show continuous data over time on an evenly scaled Axis. Furthermore, Pie charts in Excel are the ideal choice when the source data contains only one data series and no data points are negative or zero. To change this, we right-clicked the x-axis, clicked "Format Axis," and changed "Bin Width" to 10.0. If you prefer, you could adjust the
number of bins (rather than their scope). It is similar to a Pie Chart with the only difference that a Doughnut Chart can contain more than one data series, whereas, a Pie Chart can contain only one data series. And Excel provides High-Low-Close and Open-High-Low-Close Stock charts. The above Histogram plot shows four students aged 15 to 27
years and six in the age group of 27 to 39. To create a Scatter chart, arrange the data in columns and rows on the worksheet. A Radar chart has the following sub-types — Radar Radar with Markers Filled Radar Combo Chart Combo charts combine two or more chart types to make the data easy to understand, especially when the data is widely varied.
An area chart is essentially a line chart, but the area under the line is filled in. You can download the template here to use it instantly. Description The Waterfall charts in Excel display the accruing result of data points as a running total, with values getting added or subtracted. Description The Area charts in Excel help visualize a variation over time
and focus on the total value along the trend. We can use the Stock chart to display the above data for visual analysis. Step 4: Update the chart and axes titles by double-clicking the respective elements in the chart area to obtain the below Column chart. The steps to create an area chart for the above data are as follows: Step 1: Select the cell range
A2:D7 and go to Insert — Line or Area Chart — 2-D Area chart. Here we explain the list of top 10 excel charts along with examples & how to create them. There are many data points on the horizontal axis. As there are five feedback factors, the plot has a pentagon shape. Description The Line charts in Excel help display the data trends and behavior at
regular intervals. And we will see the data represented as columns raised from the X-axis till the corresponding values specified in the source data along the Y-axis. It is shown with a secondary axis and is even easier to read. A Doughnut Chart contains rings and each ring representing one data series. This is where a clustered column chart would
come in handy. It's easy to quickly identify that the team is gradually getting better in front of goal. Example The following table shows an employee’s monthly income, savings, and expenses. A Scatter plot can help us analyze the above data effectively. In a Line chart — Category data is distributed evenly along the horizontal axis. To create a Radar
chart, arrange the data in columns or rows on the worksheet. Further, Excel provides 2-D Stacked, 100% Stacked, and 2-D and 3-D Line charts. Step 2: Click the chart area to enable the Chart Elements options. Step 1: Click on a cell in the source table and select Insert — Radar chart. You want to compare many data points regardless of the time.
First, it's clear that Thursday is the best day each week for income (see how it peaks for Thursday in all three colors), and second, we're making more money as the weeks go on (notice how the orange segment takes up more of the chart's area than the blue, and how the green takes up more than the orange). Step 1: Click on a cell in the source table
and select Insert — Waterfall chart. Furthermore, the plot is useful when the data points along the X-axis are more or we must focus on patterns in massive datasets. An Area Chart has the following sub-types — Area Stacked Area 100% Stacked Area 3-D Area 3-D Stacked Area 3-D 100% Stacked Area XY (Scatter) Chart XY (Scatter) charts are
typically used for showing and comparing numeric values, like scientific, statistical, and engineering data. Square parentheses in the x-axis represent numbers included in the bin, whereas round brackets represent numbers not included in the bin. For example, let's say we tracked the number of airplanes to have flown overhead each day over three
weeks. The radar chart below clearly indicates that Tom's biggest asset is his pace, Dick is a good all-rounder, and Harry needs to improve in all areas. In this example, the color under the line is the total accumulated income, so color is good! The chart also clearly shows us that income peaked on Thursday, and dropped back off at the end of the week
to where it started on Monday. The colored areas from each trend line overlap, with the area from the last trend line to the X-axis, displayed in front. However, to achieve this, we had to take a crucial step. Types Of Charts In ExcelDownload Recommended Articles This has been a guide to Charts In Excel. And update the chart title as explained in the
previous sections to obtain the below Radar chart. A column chart has the following sub-types — Clustered Column. Step 1: Click on a cell in the source table and select Insert — Scatter or Bubble Chart — Scatter chart. In this example, we've plotted goals conceded versus goals scored. And we can view the data points in the chart as percentage shares
of the entire pie. For example, to create a simple high-low-close Stock chart, arrange your data with High, Low, and Close entered as Column headings, in that order. The above Line chart shows three data series, each for a US state’s population in the five decades. The above data can be better understood using a bar chart, and the steps to create
one are as follows: Step 1: Click on a cell in the source table and follow the path Insert - Column or Bar Chart — 2-D Clustered Bar chart. Here, you can see the number of goals a team has scored over the course of three seasons. And we see three lines in the pentagon shape joining the data points in each series, representing each customer’s
feedback. And we will see the data represented as bars starting from the Y-axis till the corresponding values specified in the source data along the X-axis. To create a Combo chart, arrange the data in columns and rows on the worksheet. Further, we will find only one category for the Waterfall charts in Excel. The resultant pie chart shows each type
as a wedge, while the doughnut chart uses arcs in a circle. The more data that you include in a scatter chart, the better the comparisons you can make. The above Scatter plot shows a highly positive and linear relationship between the hours studied and secured test scores. Other than making you feel hungry, pie and doughnut charts represent each
part of your data as a proportion of the whole. This article must be helpful to understand the Types Of Charts In Excel, with their features and examples. To create a Line chart, arrange the data in columns or rows on the worksheet. To reverse the groups (in the example above, move Monday to the top, and Sunday to the bottom), double-click the
relevant axis, and check "Categories In Reverse Order" in the Format Axis pane on the right of your screen. The top-most and bottom-most points of each line indicate the high and low temperatures on each date, respectively. You can also add data labels by selecting the chart, clicking the "+", and checking "Data Labels." Where bar and column
charts show individual values for each series, histograms group data together to show frequency distributions. Furthermore, Excel offers Radar, Radar with Markers, and Filled Radar plots. So, it makes the population comparison of the three states more straightforward than reviewing the statistics using the source table data. A Scatter chart has two
Value Axes — Horizontal (x) Value Axis Vertical (y) Value Axis It combines x and y values into single data points and displays them in irregular intervals, or clusters. Description The Radar charts in Excel help compare the aggregates of multiple data series against several criteria, such as checking temperature variations at different locations in a year.
Hover your cursor over each wedge or arc to see the exact values. In this example, the chart displays the number of airplanes (y-axis) that have flown overhead on each day (x-axis) of a given week. However, a Stock chart can also be used to show fluctuations in other data, such as daily rainfall or annual temperatures. And for a positive value, the
column raises upwards. 100% Stacked Column. In this chapter, you will have an overview of the different chart types and get to know the sub-types for each chart type. In this article, we'll look at 10 of the most useful for your everyday data, and how to use them. To create a chart, select your data, open the "Insert" tab, and click the icon in the corner
of the Charts group. Based on the type of data, you can create a chart. To create a Surface chart — Ensure that both the categories and the data series are numeric values. Description The Histogram Excel chart is similar to a Column chart. Not only do the points in the chart indicate specific characteristics, but the areas of the plots also tell us the
overall comparative values. While column and bar charts are ideal for showing comparisons of a simple data set, line charts effectively display a linear trend over time. So, the steps to change the bar orders without modifying the source data are as follows: Step 2: Click the chart area to enable the Design tab and select the Select Data option. On the
other hand, for a negative data point, the column goes downwards. And each column in the chart is called a bin, which one can modify for further data review. Let's say we're an athletics coach, and we want to see how our athletes compare in terms of their attributes. A Surface chart has the following sub-types — 3-D Surface Wireframe 3-D Surface
Contour Wireframe Contour Radar Chart Radar charts compare the aggregate values of several data series. Users can use the appropriate chart types to display massive datasets, which makes the data more meaningful. And thus, the chart helps understand the relationship between the individual data series to the whole data. Place the x values in
one row or column, and then enter the corresponding y values in the adjacent rows or columns. 3-D Stacked Column. The Select Data Source window opens. Example The following table shows the hours spent studying and the corresponding scores secured in a test. Here, our table shows the average temperature and average rainfall across a year.
Description The Column charts in Excel help show data variations over a period and compare the datasets. Further, 2-D and 3-D Clustered, Stacked, and 100% Stacked are the available Bar charts in Excel. Bar Chart Bar Charts illustrate comparisons among individual items. We can use the Line chart to represent the above population statistics
graphically. But it displays the frequency of a variable occurrence in the given range. A Combo chart has the following sub-types — Clustered Column Line Clustered Column Line on Secondary Axis Stacked Area Clustered Column Custom Combination There are 17 different types of charts in Excel, so it can sometimes be difficult to choose which one
to use. So, the bar plot with the updated data series order and chart title (by double-clicking the chart title element in the chart area) is: The bar chart makes it easier to assess the monthly savings and expenses. Step 3: Click the ‘+’ icon (Chart Elements) and check the Axis Titles box. Description Pie charts in Excel represent the size of each item in a
dataset, equivalent to the sum of the item. To create a column chart, arrange the data in columns or rows on the worksheet. We can plot the above data using a 3-D Clustered Column chart from the Insert tab. In a Bar Chart, the categories are organized along the vertical axis and the values are organized along the horizontal axis. And these come in a
variation, which is volume based. Here is how to use the Radar chart and depict the above data. However, if you have series names with lots of characters, they display better on the y-axis than on the x-axis. You want to show similarities between large sets of data instead of differences between data points. Also, a long line in a High-Low-Close Stock
chart denotes higher instability, and a shorter line indicates higher stability. A Pie Chart has the following sub-types — Pie 3-D Pie Pie of Pie Bar of Pie Doughnut Chart A Doughnut chart shows the relationship of parts to a whole. To create a Pie Chart, arrange the data in one column or row on the worksheet. It is best to use the Scatter chart when we
must modify the X-axis scale, get a logarithmic scale axis, or not have evenly spaced values along the X-axis. Step 1: Click on a cell in the source table and select Insert — Statistic Chart — Histogram chart. Step 1: Click on a cell in the source table and go to Insert — Pie or Doughnut Chart — 2-D Pie chart. The plot requires the x-values in one row or
column and the associated y-values in the next rows or columns. Column Chart A Column Chart typically displays the categories along the horizontal (category) axis and values along the vertical (value) axis. The above Column chart shows the subject-score plot, with the subjects on the horizontal axis and the scores on the vertical axis. The data points
in the source table get represented as sectors, with the sector size varying with the data point value. And then there are 2-D Line with Markers and Stacked and 100% Stacked variations of Line with Markers. Charts in Excel is an inbuilt feature that enables one to represent the given set of data graphically. It shows the plotted data points’ sum. As
with column charts, you can use clustered bar charts to visualize multiple related data series at the same time. Using this type of chart makes it easier to estimate percentages. To create an Area Chart, arrange the data in columns or rows on the worksheet. To create a Doughnut Chart, arrange the data in columns or rows on a worksheet. Example
The following table contains customers’ ratings based on five factors. Click on the first series in the Legend Entries field and click the down arrow twice to move it and display it as the last series. Excel offers 2-D and 3-D Pie, 2-D Pie of Pie, and Bar of Pie charts. The color key will appear automatically. The benefit of the chart having this additional
color is that it more clearly represents large variations in data. You can learn more from the following articles - Excel provides you different types of charts that suit your purpose. Further, each column starts where the previous column ends. Example The following table shows the monthly sales at a firm in 2021-22. The reason for selecting the entire
table is the merged cell on top of the table. Example The below table shows a five-day daily high, low, and average temperature data. It is available as a group in the Insert tab on the Excel ribbon, with different charts grouped into eight categories. Example The below table shows the decade-wise population in three US states. A Bubble chart has the
following sub-types — Bubble Bubble with 3-D effect Stock Chart As the name implies, Stock charts can show fluctuations in stock prices. The data points in a pie chart are shown as a percentage of the whole pie. These types of charts allow you to see optimal combinations between different data sets using a 3D map and colors. And the chart appears
as a spider web or star. The plot helps visually review the firm’s performance in each quarter of 2022. A Line chart has the following sub-types — Line Stacked Line 100% Stacked Line Line with Markers Stacked Line with Markers 100% Stacked Line with Markers 3-D Line Pie Chart Pie charts show the size of items in one data series, proportional to
the sum of the items. If you have more than one variable in your table, Excel will pick these up when you choose to represent your data as a line chart. Whether you’'re a beginner or an experienced user, this bundle covers it all - from Basic Excel to Advanced Excel, Macros, Power Query, and VBA. By doing so, we will see the fields to update the
vertical and horizontal axes titles in the chart area.
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